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Check Index Project

Purpose

One decisive key figure of high response time is the correct use of indexes. The Progress’ algorithm
 that decides which indexes are used and bracketed is relatively unknown by many developers. The way to check indexes usage isn’t so easy either (compile program with the XREF keyword, check all SEARCH entries and compare index’ structure with the fields used in WHERE clause).

The purpose of this tool is to ease this check by showing in one single screen the FIND or FOR statements and the structure of the used indexes.

Reminder

If the keyword “WHOLE-INDEX” 
 appears for any SEARCH line, this means that all the records must be scanned to achieve the request. This normally happen if the request is a FOR EACH without WHERE clause. But it’s a bad thing if it happens on any other circumstances.

Some of you know it, some other don’t, but there’s a critical difference between a FIND and a FOR statement by terms of index usage.

Progress doesn’t improve the FIND algorithm for a long time now. You must try to use as much as possible the FOR statement, because:

· In a client/server environment, using the FIELDS option may dramatically reduce the network traffic;

· FOR statement has the ability to combine indexes!

Limitation

Unfortunately, there is one (severe) limitation with this tool.

This version is not looking deep in the queries. It actually considers that all the fields referenced in the query (through ACCESS lines of the XREF file) are used in the WHERE clause with AND operators and equality matches.

In another hand, I can’t guarantee a perfect scoring of each SEARCH statement. I’ve tried to handle many situations, but sometimes, scores may seem curious.

However, the purpose is to fix your attention to possible problems in SEARCH statements, which are the base of all database access, and the source of many performance troubles.

On another hand, due to usage of external API procedures, the Batch version only runs on 32bits based systems.

Set up

This tool has been developed using Progress V9.1b.

Extract the ZIP file (this will create a Progress\ChkIdx directory).

For a correct set up, please modify the chkidx.ini file to match your Progress installation (DLC, PROMSGS, PROPATH).

To set up a test environment, please create a copy of the sports2000 database. Modify then the chkidx-dft.pf file to match the location of your sports2000 database, and rename it chkidx-sport.pf.

Create the following shortcut:


Target: 
%DLC%\bin\prowin32.exe 
–pf chkidx-sport.pf 
–basekey ini 

–ininame chkidx.ini 

–p prog\idxgui.w


Start in:
C:\progress\chkidx
The Project

There’s actually two ways to analyse index usage: The Graphical (GUI) version and the BATCH one.

To fully analyse Index Usage, it is necessary to connect the databases used within the analysed program and to make the P-File (or W-File) and all its Include-Files available for scanning. Using the Graphical version, you can connect databases using the File/Database Connection menu. With the BATCH version, you have to connect databases by yourself.

The Batch version

You launch this version by running the “idxbat.p” program. It requires 6 input parameters:

1. A character string: the directory where to find the XREF files to analyse;

2. A character string: the XREF filenames’ mask for filtering (by default “*.xrf”);

3. A character string: the output format, either “excel” or “text”;

4. An integer value: the sort order, either 1 (for Score #1) or 2 (for Score #2);

5. A decimal value: the maximum score you want to be displayed;

6. A logical value allowing you to skip analyse of temp-tables.

If you export results to an Excel file, the program will open an Excel session, create a new workbook and generate as many worksheets as there are XREF files to analyse. Each worksheet is named with the related XREF file. If something goes wrong while attempting to create an Excel session, the tool automatically switches to an “export to text” mode.

If you export results to a Text file, the program will generate as many text files as there are XREF files to analyse. These text files are located in the same directory as XREF files and shared the same names. They have the CIX extension and are pipe-separated fields.

Remark: You can’t start a Progress session with “-p idxbat.p” because the program requires parameters (and you can’t run a program that needs parameters from the –p startup parameter). So you’ll have to create another P file that actually calls the “idxbat.p” (please refer to the call-idxbat.p sample file).

The Graphical version

When you launch this version, you are prompted for a valid Progress XREF file to analyse. Once selected, the analysis process is automatically started. A progress bar appears at the bottom of the screen.

The Index Check highlights abnormal “WHOLE-INDEX” keyword in two ways: The bad line is shown with a red background in the browse and a red message appears above the “Look for table” combo-box.
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The upper-left browse shows all SEARCH lines analysed in the XREF file. These are the displayed fields:

	Field
	Description

	Score
	A percentage giving the ratio between the fields used in the search statement and those composing the used indexes

	Database
	The name of the database to what the table belongs

If the search is based on a temp-table, then this field is set to TEMPTABLE

	Table
	The name of the table

	Filename
	The filename referenced in the XREF file

	Line
	The Line number referenced in the XREF file


The Browser’s tool-tip shows you the current Procedure and Filename.

The upper-right browse shows all the indexes (and their fields) used in the currently selected SEARCH statement. These are the displayed fields:

	Field
	Description

	Index
	The name of the used index

	Field
	The fields composing the index

	Sort
	The field sort within the index (Asc or Desc)


The bottom part of the screen shows the content of the Filename of the currently selected SEARCH line. This FIND or FOR statement is highlighted within the file.

You can maximize this editor by clicking on the button at its bottom right corner. You are also allowed to make “find” and “go to line” using the “Search” menu.

Main Browse Filters

You may filter the content of the SEARCH browse selecting one of the three following options:

· ALL

shows all SEARCH statements;

· (Can-) FIND
shows FIND and CAN-FIND statements;

· FOR

shows FOR (FIRST, PREV, NEXT, LAST, EACH) statements.

You may also restrict the browse display to a given table, using the “Look for table” combo-box.

Main Browse Sort

You may sort the content of the SEARCH browse by ascending line or scores.

Menus

These are the menu-items of the “File” menu:

	Menu Item
	Description

	Analyse XREF (F4)
	Prompt you for a valid Progress XREF file to analyse

	Export to Excel
	Export the current analysis to an excel worksheet

	Export to Text file
	Export the current analysis to a text-file

	Exit
	Exit the Check Index Tool


These are the menu-items of the “Search” menu:

	Menu Item
	Description

	Find
	Find a string in the source-file editor

	Find Next
	Find the next occurrence of the searched string

	Find Previous
	Find the previous occurrence of the searched string

	Goto Line
	Go to a line number


These are the menu-items of the “Tools” menu:

	Menu Item
	Description

	Show All Indexes (F5)
	Display (at the upper-right side of the main screen) a browse showing all the existing indexes of the currently selected table.

	Count Records (F6)
	Display (at the bottom right side of the main screen) a browse showing the number of records in the currently selected table.

This menu-item is disabled if the selected table is a temp-table.

	Search Statistics (F7)
	Display a dialog-box showing statistics about Searches in the currently analysed program

	Database Connections
	Display the Progress’ Database Connection dialog-box

	Data Dictionary
	Display the Progress’ Database Dictionary


These are the menu-items of the “Options” menu:

	Menu Item
	Description

	Analyze Temptables
	Activate or deactivate analyse of temp-tables

	Disconnect Databases
	Disconnect or leave databases connected when leaving the tool

	Keep last Path
	Keep the last path as default path, or leave it to its default value

	Refresh All Indexes
	Refresh the All Indexes’ browse when selecting a SEARCH

	Set Default Xref Path
	Set the default Xref path


These are the menu-items of the “Help” menu:

	Menu Item
	Description

	Score Algorithmes…
	Describe the way scores are calculated

	About…
	Show the classical About dialog-box


Save Options

Settings under Options menu and windows’ position are saved when leaving the tool. They are stored in the session’s INI file, under the [ChkIdx] section.

Score calculation

There are two ways to score SEARCH statements:

1. Number of indexed fields in WHERE clause divided by the total number of fields in the WHERE clause;

2. Number of indexed fields in WHERE clause divided by the total number of fields in the used index(es);

Let’s consider a table with only one index defined: the primary/unique key is Fld-A and Fld-B.

Now compare the scoring algorithms with the following WHERE clauses:

	WHERE Clause
	Score (Algorithm #1)
	Score (Algorithm #2)

	Fld-A and Fld-B and Fld-C
	66%
	100%

	Fld-A and Fld-C
	50%
	50%

	Fld-A and Fld-C and Fld-D
	33%
	50%

	Fld-A and Fld-C and Fld-D and Fld-E
	25%
	50%


As you can see here, the algorithm #2 may be more relevant than #1 because performances are indeed equivalent for all the WHERE clauses. On another hand, algorithm #1 is more accurate and restrictive.

For this reason, we suggest you to compare both scores and consider one or the other following this theory:

If Algorithm #2’s score is lower than Algorithm #1’s one, then consider Algorithm #1’s score, otherwise, consider Algorithm #2’s score.

Scoring a FIND or CAN-FIND statement

It was said before; FIND and CAN-FIND statements can’t combine indexes. So one and only one index will be used to execute the query.

First of all, the program looks for the fields used in the query. Then it looks sequentially for the fields in the index structure. The number of fields used in the query that are consecutively part of the used index gives the score. This comparison is stopped when a field in the index is not present in the query.

Example: Let’s consider the following SEARCH: 

FIND Table WHERE Fld-A = 10 AND Fld-B = 20 AND Fld-C = 30 NO-LOCK NO-ERROR.

	Used Index
	Score (Algorithm #1)

	Fld-A ; Flb-B ; Fld-C
	100% (All SEARCH fields are in the index)

	Fld-A ; Fld-C
	66% (Fld-A and Fld-C in the index / 3 SEARCH fields)

	Fld-A ; Fld-D ; Flb-B ; Fld-C
	33% (Fld-A in the index / 3 SEARCH fields) 

Because Fld-D is not in the SEARCH

	Fld-D
	0% (no SEARCH fields in the index)

Raises bad WHOLE-INDEX 


Scoring a FOR statement

FOR statements allow indexes combination. So the scoring is simply the difference between the number of fields used in the query and the number of related fields in the indexes combination.

Programs Index

	Program Name
	Description

	IdxBAT.p
	Main program of the Batch version

	IdxGUI.w
	Main screen of the graphical version

	Idx002.p
	Index Structure analyse

	Idx003.w
	Browse on all existing indexes for a given table

	Idx004.w
	Browse on record counter

	Idx005.p
	Record counter routine

	Idx006.w
	Scoring Algorithm description

	Find.w
	“Find” Dialog-box

	GotoLine.w
	“Goto Line” Dialog-box


	Include Name
	Description

	Idx001.i
	Temp-table definition for indexes

	Idx002.i
	Temp-table definition for Record Counter

	Idx003.i
	Temp-tables definitions shared by GUI and BATCH versions

	Idx004.i
	XREF-Analyse procedure

	Idx005.i
	IdxOnRealTable-Analyse procedure

	Idx006.i
	IdxOnTempTable-Analyse procedure

	Idx007.i
	User-defined function(s)

	Idx008.i
	XREF-Import procedure

	Idx009.i
	Temp-Table deletion procedure

	Idx010.i
	Excel-Open procedure

	Idx011.i
	Excel-Close procedure

	Idx012.i
	Xref-export procedure

	Idx013.i
	Xref-export-data procedure


Troubleshooting

The Index Browse is empty

The program was unable to analyse the index structure.

Verify that all the required databases are connected.

Special characters are displayed as black boxes

This is due to the code-page used in the Xref file.

Look for CPINTERNAL and CPSTREAM in the first lines of the Xref file. Then, modify the parameter file used to launch the tool in order to match the settings in the Xref file: 

-CPINTERNAL IBM850 (or ISO8859-1)

-CPSTREAM     IBM850 (or ISO8859-1)

Settings are not saved

Check if the ChkIdx INI file is not write-protected.

� See the Progress Database Design Guide, Chapter 4: Defining Indexes, Paragraph 13: How Progress Chooses and Brackets Indexes to Satisfy Queries


� See Progress Knowledge Keybase #15253
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